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 Wordآشنايي با نرم افزار 

 شود.  است كه براي تايپ، ويرايش و طراحي متون استفاده مي» پرداز واژه«يك نرم افزار  Wordنرم افزار 
 1989اما پس از آن و در سال  .منتشر شد» مكينتاش«براي كامپيوتر اپل و سيستم عامل  1984نرم افزار نخستين بار در سال اين 

 تبديل شد. Officeاين برنامه به جزئي از مجموعه نرم افزاري 

اين   Word 2010آشنا شويم. دليل انتخاب ما براي آموزش  2010از مجموعه آفيس  Wordما در اين دوره قرار است با نرم افزار 
شباهت زيادي به اين نسخه  ،افزار هاي اين نرم و ساير نسخه كنند از اين مجموعه استفاده مي است كه بسياري از كاربران ايراني

 دارد.

 Wordدر يك سند ي اصلي ها معرفي بخش

 و همچنين Wordها و زبانه ها در يك سند  ها، گزينه بهتر است با بخشپيش از آنكه نخستين پروژه تايپ را انجام دهيم، 
  كاربردهاي آنها آشنا شويم.

، گزينه ها و ابزارهايي وجود دارد كه در زير به طور خلاصه Wordطور كه در تصوير زير مي بينيد، در صفحه اصلي يك سند  همان
هاي بعدي با آنها بيشتر آشنا خواهيم  تر دارد كه در درس نياز به توضيح مفصلها  دهيم. برخي از گزينه كاربرد هر مورد را توضيح مي

 شد.

 
هاي موجود در  مشاهده خواهيد كرد كه با استفاده از گزينه اي را صفحه. اگر بر روي اين دكمه كليك كنيد، Fileدكمه  :1شماره 

را باز و ويرايش كرد. همچنين براي ذخيره، چاپ، بستن سند  ايد كار كرده آن، مي توان سند جديدي ايجاد كرد، يا سندي كه قبلاً
 توان از گزينه هاي اين دكمه استفاده كرد. و... مي
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توانيد  برخي ابزارها هستند كه كاربرد زيادي دارند. شما مي Wordافزار  . در نرمAccess toolbarبخشي است به اسم  :2شماره 

 تر باشد. كنيد تا دسترسي به آن ساده تر و سريع ابزارهاي دلخواهتان را به اين بخش اضافه

بزرگ و كوچك كردن سند استفاده بندد. دكمه وسط براي  را مي Wordداراي سه دكمه است. دكمه ضربدر، سند : 3شماره 

ور كند. بدين صورت كه بدون اينكه سند را به ط مي» مينيمايز« شود و دكمه سمت چپ حالتي ست كه يك سند را اصطلاحاً مي
كند تا شما بتوانيد به كارهاي ديگري كه در ويندوز برايتان پيش آمده،  كامل ببندد، آن را به پايين صفحه ويندوز هدايت مي

 رسيدگي كنيد.

ها و منوهاي  در اين بخش قرار دارد. با كليك بر روي هر كدام از اين زبانه ها، بخش Wordهاي اصلي نرم افزار  زبانه: 4شماره 

 آن نمايش داده مي شود.مربوط به 

زبانه از چند بخش و يك سري گزينه تشكيل شده، كه هر كدام از آنها، كاركرد و قابليت خاص خودشان را دارند. در  هر: 5شماره 

كليك كنيد،  Insertنمايش داده شده است. اگر بر روي زبانه  Homeهاي مربوط به زبانه  ، بخش5تصوير فوق و در عدد شماره 
 متفاوت است. Homeبا بخش هاي  ، كاملاInsertًهاي  يد كه بخشخواهيد د

 توان اندازه صفحه را با آن تنظيم كرد.  خط كش است كه مي :6شماره 

توان  نامند. با تغيير محل مكان نما، مي مي» مكان نما«مي بينيد را  Wordزني كه در صفحه سفيد سند  علامت چشمك: 7شماره 

 شان درج كرد.واژه ها را در محل مناسب

توان  و بالا و پايين كردن آن، مي Scroll Barنامند. با نگه داشتن ماوس بر روي آيكون  مي» Scroll Bar«اين آيكون را : 8شماره 

 ، دسترسي پيدا كرد.Wordبه محل مورد نظر در يك سند 

 صفحه در سند و نمايش زبان انتخابي.هاي تايپ شده، وضعيت  دهد: تعداد لغت اين بخش، وضعيت سند را نمايش مي: 9شماره 

توان در  كنيد، مي كه در سمت چپ آن مشاهده مي» درصد«هاي نمايشي است. با استفاده از اين ابزار و علامت  حالت :10شماره 

را تر ديد. كافي است ماوس را بر روي زبانه مشخص شده نگه داشته و آن  كرد و حروف را به صورت درشت» زوم«متن نوشته شده 
 به سمت چپ و راست ببريد تا تغييرات را مشاهده كنيد.

تواند  ميWordتوان يك حالت نمايشي مناسب براي نوشتن متون انتخاب كرد. يك سند  ها مي با استفاده از اين گزينه :11شماره 

ماوس بر روي هر كدام است. با نگه داشتن  Print Layoutصورت نمايش داده شود كه حالت پيش فرض و بهينه آن، حالت  5به 
توانيد نام شكل نمايشي را ببينيد و در نهايت با دو بار كليك  كنيد، مي هايي كه در سمت چپ ابزار تغيير زوم مشاهده مي از گزينه

 كردن، يك شكل نمايشي را انتخاب كنيد.
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  هاي اصلي معرفي زبانه

هاي  شوند. البته يك سري زبانه دسته تقسيم مي 7به  Wordهاي اصلي نرم افزار  ديديم، زبانه 1همانطور كه در تصوير شماره 
 پردازيم. هم وجود دارد. در زير به معرفي كاركرد زبانه هاي اصلي مي» مخفي«

 Homeزبانه  •

 

 دهد. هاي اين زبانه، امكان تايپ متن، ويرايش، تنظيمات پاراگراف و ... را به شما مي گزينه

 Insertزبانه  •

 طور به. كنيد درج سند يك در را... و نمودار عكس، جدول، قبيل از مواردي توانيد مي ،Insert زبانه هاي گزينه مجموعه از استفاده با
 .شود مي استفاده زبانه اين از سند، يك در چيزي هر »درج« براي كلي

 Page Layout زبانه •

آقاي  جناب 

هاي  سازي صفحات از گزينه صفحه در يك سند است. به طور كلي براي پيكربندي و بهينههاي اين زبانه مربوط به تنظيمات  گزينه
 شود. اين زبانه استفاده مي

 Referencesزبانه  •

هايي همچون  ايجاد كرد. طرح Wordهاي خاصي در يك سند  صفحات و طرحپاورقي، توان   هاي اين زبانه مي با استفاده از گزينه
 قابل ايجاد است. Referenceو... از طريق زبانه » اعلاميه«، »تقديرنامه«

 Mailingsزبانه  •
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هاي دلخواه استفاده  براي ارسال ايميل با طراحي Wordهاي نرم افزار  توان از ويژگي مي Mailingsهاي زبانه  با استفاده از گزينه
 كرد.

 Reviewزبانه  •

 ج

گر واژگان را به دلخواه خودتان  تصحيح توانيد تغييرات خاصي در نرم افزار ايجاد كنيد. مثلاً هاي اين زبانه مي با استفاده از گزينه
 تان را با متون ديگر مقايسه كنيد و... . براي بهبود كيفيت متن خود استفاده كنيد، متن Wordتنظيم كنيد، از مترجم اسناد 

 Viewزبانه  •

كل نمايش صفحه را انتخاب كرد، توان ش مي شود. مثلاً استفاده مي Wordي شيوه نمايش يك سند هاي اين زبانه برا از گزينه
 Wordهاي دلخواهي را در صفحه نمايش يك سند  توان گزينه توان سند را در حالت بزرگنمايي تماشا كرد و... همچنين مي مي

 اضافه يا حذف كرد.

 Wordاصول مهم شروع كار در نرم افزار 

 به دو نكته توجه كرد:بايست  ع كار با اين نرم افزار ميوشراز و پيش  Wordيك سند س از باز كردن پ

كه در تصوير ذيل با فلش را  Right-to-Left Text Directionگزينه  Homeچنانچه زبان سند فارسي است، در زبانه  -1
 صورت استاندارد استفاده نماييم.ها به  ينهزانتخاب كنيم تا بتوانيم از ساير گ ،ايم مشخص كرده

برخي از تنظيمات اوليه را  Advancedو انتخاب گزينه  Word Optionو كليك بر روي گزينه  Fileدكمه با كليك بر روي  -2
 دهيم: انجام مي
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گزينه Number، براي بخش When Selectedگزينه  Field Shading، براي بخش Show Document Contentدر قسمت  -
Context  و براي بخشMonth names  گزينهEnglish Transliterated هايي از متن كه  نماييم تا در قسمت را انتخاب مي

 هايي كه انگليسي است، عددها به انگليسي نمايش داده شوند.  فارسي است، عددها به فارسي و در قسمت

نماييم تا  را انتخاب مي Centimetersگزينه  Show measurements in units of، براي گزينه Displayهمچنين در قسمت  -
 متر انجام شوند.  بندي بر اساس واحد سانتي تنظيمات صفحه

بسيار وسيع است و توضيح تمام اين موارد در اين جزوه  Wordبايد توجه داشت كه منوها و ابزارهاي نرم افزار 

نامه و رساله مورد نياز دانشجويان عزيز  براي تنظيم پايان پذير نيست. بنابراين به مطالبي خواهيم پرداخت كه امكان

 باشد.  مي

  است. Page Layout زبانهبه آن نياز داريد،  بندي صفحات قالببراي اي كه شما  مهمترين زبانه

رود. اگر بخواهيد شروع و پايان يك متن، به ميزان  براي تنظيمات اوليه يك صفحه به كار مي Page Layoutهاي بخش  گزينه
 مي توانيد اين عمليات را انجام دهيد. Marginsبا استفاده از گزينه   مشخصي از سمت چپ و راست و بالا و پايين صفحه درج شود،
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 ارند:اي د هايي هستند كه تنظيمات از پيش تعيين شده و .... گزينه Narrow ،Moderate ،Wide هاي گزينه

  

 دهد: تنظيمات دلخواه را انجام مي Custom Marginsاما گزينه 
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 تنظيمات مورد نظر خود را انجام دهيد. Rightو  TOP ،Bottom ،Leftهاي  كافي است با وارد كردن عدد دلخواه در قسمت

  شوند، براي تنظيم صفحات مطابق اين دستور عمل نماييد: به صورت دو رو پرينت گرفته مي براي پرينت اسناد

 
 

 را Mirror Margins گزينـه  Multiple Pageشود با اين تفاوت كه بـا اسـتفاده از گزينـه     در اين روش مانند روش قبلي عمل مي
 .  نماييم تا صفحات به صورت زوج و فرد تنظيم شوند انتخاب مي

 عمودي و افقي كردن صفحه

است. با استفاده از گزينه  A4در حالت پيش فرض، صورت مستطيلي شكل و شبيه به يك برگه  Wordيك صفحه از يك سند 
Orientation .مي توان صفحه را به حالت افقي يا عمودي تنظيم كرد 
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 تغيير اندازه صفحه

و يا به اندازه هاي دلخواه ديگر تغيير  B5و  B4و  A5و  A4و  A3ه حالت هاي مي توان اندازه صفحه را ب Sizeبا استفاده از گزينه 
 داد.

 

انتخاب كنيد. براي اين كار،  را صفحه خود توانيد اندازه دلخواه بينيد، مي هاي مشخصي كه در اين گزينه ها مي فرض علاوه بر پيش
 ، طول و عرض صفحه را وارد كنيد.Heightو  Width) را انتخاب كنيد و از بخش More Paper Sizesآخرين گزينه (

 

 

 

 

 

 

 

 



 9 ارشد و رساله دكتري نامه كارشناسي براي تدوين پايان Word 2010  افزار آموزش نرم
 

 بندي) Sectionبخش بندي (

هاي  توانيد چيدمان ) آشنا شويد. به كمك بخش ميSectionبراي ايجاد يك بخش جديد در ابتدا لازم است با مفهوم بخش (
هاي متعددي در يك  فايل ايجاد نماييد و در  بخشتوانيد  مختلف در داخل يك صفحه و يا بين صفحات را داشته باشيد. شما مي

هاي متفاوت، اندازه كاغذ و جهت افقي يا عمودي بودن  هاي متفاوتي اعمال كنيد؛ از قبيل حاشيه هاي مختلف، فرمت اين بخش
 صفحات، شماره صفحه و سرصفحه و پا صفحه متفاوت و ...

 خواهيد: به عنوان مثال اگر مي

 گذاري شود، ه صورت الفبايي باشد و مابقي با اعداد شمارهشماره برخي از صفحات ب •

 ايد، نياز داريد تا يك صفحه افقي براي رسم يك جدول يا نمودار داشته باشيد، اگر در بين گزارشي كه تهيه كرده •

 ها متفاوت باشد، سرصفحه هر فصل از ساير فصل •

انيد تمام اين موارد را در يك فايل انجام دهيد. فقط كافي است يك تو هاي جداگانه آنها را تهيه كنيد. بلكه مي نيازي نيست فايل
Section ها را قطع كنيد تا  متن هستند، ايجاد كرده و ارتباط بين بخش هاي ساير بخشهايي كه متفاوت از  جديد براي قسمت

 بايست مطابق با اين روش عمل نماييد: مي Sectionقادر باشيد فرمت آنها را جداگانه تعيين كنيد. براي ايجاد يك 

Page Layout→Breaks→Next Page 

ارتباط وجود دارد و  ها در متن خود هستيد. اما در حال حاضر بين بخش يا چند بخش با اعمال اين دستور، شما داراي دو بخش
تأثيري نداشته باشد. بنابراين با دبل كليك  بايست اين ارتباط قطع شود تا تغييرات ايجاد شده در يك بخش، بر روي بخش ديگر مي

 بر يك جاي خالي در بالا و يا پايين يكي از صفحات بخش جديد ايجاد شده، از طريق منوي
Header & Footer Tools→Design،  گزينهLink to Pervious نماييم. با انجام اين كار  را با كليك بر اين بخش، غير فعال مي
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كار خواهيد شماره و عنوان صفحه در بخش بالا قرار گيرد، اين  شود. دقت كنيد اگر مي ارتباط بين بخش دوم و بخش اول قطع مي
 انجام دهيد.  Footer خواهيد در بخش پايين قرار گيرد، اين كار را در بخش و اگر مي Headerرا با دبل كليك در بخش 

 

 استفاده از بخش بندي ايجاد سرصفحه به صورت زوج و فرد با

خواهيم  اي كه مي    به صفحه) جداگانه در نظر گرفته شود. پس از آن Sectionاين كار بايد براي هر فصل يك بخش ( انجام براي 
رويم. سپس مكان نماي ماوس را در بخش مورد نظر خود (كه براي شماره بندي صفحات به  گذاري از آنجا آغاز شود مي شماره

 تا صفحه بدين شكل شود: .كنيم و دبل كليك مي بريم صفحه) ميابتداي 
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 گزينه Insertكنيم و از منوي  فعال ميرا  Right-to-Left Text Directionگزينه  Homeسپس از طريق منوي 
 Page Number  را انتخاب كرده و از طريق گزينهTop of Page وضعيت ،Plain Number 1 كنيم: را انتخاب مي 

 

را انتخاب كرده و  Borderگزينه  Homeيا فصل، فونت لازم را به آنها داده و از طريق منوي  از درج شماره صفحه و عنوان پس
 نماييم: مطابق با شيوه تصوير زير خط ممتد را ايجاد مي
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را فعال كرده تا بتوانيم  Different & Even Pageگزينه  Header & Footer Tools→Designسپس از طريق منوي  
توانيم صفحه اول هر فصل را  مي Different First Pageها را به صورت زوج و فرد تعريف كنيم و با فعال كردن گزينه  سرصفحه

 كنيم.گذاري و سرصفحه  فاقد شماره

 
 

 گذاري الفبايي صفحات شماره

اي را تعريف كرده و  بايست ابتدا بخش جداگانه عريف شود، ميبراي فصولي كه نياز است شماره صفحات آنان به صورت الفبايي ت
، Number Format، بخش Page Number Formatرا انتخاب كرده و از منوي  Page Numberگزينه  Insertسپس از منوي 

 Bottomمراجعه كرده و از طريق گزينه  Page Numberكنيم. پس از آن مجدداً گزينه به  مي Okحروف ابجد را انتخاب كرده و 

of Page وضعيت ،Plain Number 2 كنيم تا حروف ابجد در قسمت پايين صفحه نمايش داده شوند را انتخاب مي. 

 ساخت فاصله مجازي (نيم فاصله)

دهد. براي  هم قرار مي شود كه در عين نچسباندن دو بخش يك كلمه، آنها را كنار فاصله مجازي (نيم فاصله) به وضعيتي اطلاق مي
 –ه همراه ب Ctrlشود. البته كليد تركيبي  استفاده مي Ctrl+ Spaceو  Shift+Spaceفاصله معمولاً از كليدهاي تركيبي  ايجاد نيم

دهد. اما روش صحيح براي ايجاد نيم فاصله استفاده از دو كليد تركيبي اول است كه نياز به  نيز اين كار را انجام مي (خط فاصله)
  More Symbolرا باز كرده و روي گزينه  Symbolمنوي  Insertتنظيمات اوليه دارد. براي ايجاد اين تنظيمات، در انتهاي زبانه 

 No-Width Optional Breakرا فعال نموده و روي عبارت  Special Characterه، زبانه كليك كنيد. سپس در پنجره ظاهر شد
 كليك كنيد. 
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كليك كنيد. بدين ترتيب پس  Insertبراي ايجاد نيم فاصله استفاده نماييد، روي گزينه  Shift+Spaceخواهيد از كليدهاي  اگر مي
 شود.  تركيبي بين كلمات دو بخشي، فاصله مجازي ايجاد مي Ctrl+ Spaceاز بستن پنجره با فشاردادن كليدهاي از كليد 

كليك كرده تا پنجره  Shortcut Key، بر روي گزينه مد نظر شماستبراي ايجاد نيم فاصله  Ctrl+ Spaceاز كليد  اما اگر استفاده
Customize Keyboard نما را در كادر  ظاهر شود. حال مكانPress New Shortcut Key  داده و پس از فشاردادن قرار

 كليك كنيد.  Assignبه صورت همزمان روي دكمه  Space  و Ctrlكليدهاي 
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 شود.  تركيبي بين كلمات دو بخشي، فاصله مجازي ايجاد مي Ctrl+ Spaceبدين ترتيب پس از بستن پنجره با فشاردادن كليدهاي از كليد 

 هاTabروش ايجاد 

 Options  Line كليك كرده و گزينه Line Spacingبر روي گزينه  Homeاز زبانه ، ها پاراگراف خط اولدر تورفتگي براي ايجاد  

Spacingكنيم. را انتخاب مي 
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 Okو بر كليد را انتخاب  Special  ،First Line از گزينه ووارد  را 7/0عدد براي مثال  Byدر كادر  Indentionسپس در بخش 
 كنيم.  كليك مي

 كليك كرده و گزينه Line Spacing گزينهبايست از  در خط دوم و سوم و ... مي Tabبراي ايجاد 
Options  Line Spacingسپس در بخشكنيم.  را انتخاب مي  Indention در كادر By از گزينهو را وارد  مورد نظر عدد 

Special گزينه Hanging  را انتخاب كرده و بر روي كليدOk كنيم. كليك مي 
 

 

 ايجاد پاورقي

 عنوان به آن از معمولاً كه كرد درج بيشتري توضيحات هايي واژه براي اسناد، در كه است نياز گاهي دانيد مي كه طور همان
 كنيد، كليك بار يك كنيد، درج پاورقي برايش خواهيد مي كه اي  واژه از بعد ابتدا پاورقي، يك درج براي. شود مي ياد »پاورقي«

 منتقل صفحه پايين به خودكار طور به حالت اين در. كنيد انتخاب را Insert Footnote  گزينه Reference منوي از سپس
 .بنويسيد پاورقي در را نظر مورد واژه به مربوط توضيحات توانيد مي و شد خواهيد

 اين در. كنيد حذف را پاورقي شماره بايدبلكه . كنيد پاك را آن توضيحات توانيد نمي پاورقي، يك حذف براي :پاورقي حذف

 .شد خواهد حذف نيز مربوطه توضيحات كه ديد خواهيد صورت
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 :كنيد كليك را شده داده نشان زير تصوير در كه كوچكي دكمه پاورقي، ويرايش براي :پاورقي ويرايش

 

 

 

 شود: اي، مطابق شكل زير باز مي در اين صورت پنجره

          

تواند پايين صفحه و يا بلافاصله  توانيد محل قرارگيري پاورقي را مشخص كنيد. اين محل مي مي Footnotesا استفاده از بخش ب
 پس از اتمام متن مورد نظر باشد.

توان به جاي شماره  مي Number formatدر بخش  توانيد ساختار و شكل پاورقي را مشخص كنيد. مثلاً نيز مي Formatدر بخش 
 استفاده كرد.گذاري، از حروف نيز 

هاي رسمي،  ها و مقاله كتابها، رسالات،  نامه پايانگيرد. در  گذاري پاورقي صورت مي نيز براي تنظيمات شماره Numberingبخش 
 گذاري به صورت پيوسته ، شمارهWordافزار  در نرمدر حالت پيش فرض است. اما » صفحه به صفحه«گذاري به صورت  شماره

)Continues ( است. براي تغيير اين مورد از بخشNumbering گزينه  Restart each page د.را انتخاب كني 
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 خط جدا كننده پاورقي ايجاد تغيير در حالت پيش فرض

ها  چه تمام زير نويس چنان شود توصيه مي) به طور پيش فرض، از چپ به راست قرار دارد. Separatorخط جدا كننده پاورقي (
باشند، خط جداكننده متن از  ها انگليسي چه تمام زير نويس چين و چنان خط جداكننده متن از زيرنويس بايد راست فارسي باشد،
 چين شود. بايست چپ زيرنويس مي

 را انتخاب كنيد. Draftگزينه   Viewبراي اينكه اين خط را از راست به چپ تنظيم كنيد، ابتدا از منوي 

اي در  صورت پنجره پاورقي درج شده، بر روي عدد درج شده دو بار كليك كنيد. در اين هاي رهشمايكي از اكنون در محلي كه 
 :شود پايين صفحه، مطابق شكل زير باز مي

خطي به نمايش در خواهد آمد كه را انتخاب كنيد. در اين حالت  Footnote Separatorهاي موجود، گزينه  كنون از گزينها
  و با راست چين كردن، خط را از سمت راست به چپ تنظيم كرد. Homeتوانيد با مراجعه به منوي  مي

بايست به  هاي فارسي و انگليسي به صورت همزمان استفاده شده بود، خط جداكننده زيرنويس مي نامه از زيرنويس اگر در متن پايان
از  و Homeبا مراجعه به منوي كنيم و  Deleteكرده و آن را  Selectبراي اين كار بايد خط پيش فرض را  صورت خط ممتد باشد.

را انتخاب كرده تا خط ممتد مورد نظر درج شود. پس از انجام اين كار خواهيد ديد كه اين  Border ،Bottom Borderگزينه 
 را انتخاب كنيد. Print Layoutحالت  Viewبراي بازگشت به حالت سابق، از منوي  ها ايجاد شده است.  تغييرات در تمام پاورقي

 ايجاد خودكار فهرست مطالب

 زير و ها خشب ،ها فصل عنوان شامل فهرست يك. ندباش مطالب فهرست داراي بايست مي دكتري هاي رسالهو  ها نامه پايان تمام
 .است شده درج عنوان هر مقابل در ها آن ارجاع هاي صفحه شماره كه باشد ميها  عنوان

 اين دستي صورت به فهرست كردن درج .كنند يمدرج  ، فهرست را به صورت دستيخود نامه پايان نوشتنپس از  دانشجويان اغلب
 نشده روز به مطالب فهرست شوند، جا به جا متون...  و ها فصل محل تغيير قلم، اندازه تغييرمانند  دليلي هر به اگر كه دارد را اشكال

 . طلبد مي زيادي وقت كار اينو  نمايد فهرست درج به اقدام مجدد بايد كاربر و

، فهرست را تهيه كرد تا پس از ايجاد هر تغيير بدون Word برنامه خودكار فهرست ايجاد قابليت از بنابراين بهتر است با استفاده
 زحمت فهرست را به روزرساني كرد. 
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 بق با اين روش عمل نماييد: براي ايجاد فهرست خودكار مطا

مطابق با شكل زير باز  اي نجرهتا پ كنيم ميبر كليدي كه با فلش مشخص شده است، كليك  Styleو بخش  Homeاز طريق منوي 
  شود:

 مطابق با شكل زير باز شود:  اي پنجرهكنيم تا  يكليك م Save Selection as a New Quick Styleسپس از بر روي گزينه 

 

انتخاب و پس از آن بر   شوند،تعريف براي عناوين اصلي ما  فرض يشبه صورت پي خواهيم مينامي براي حالتي كه  Nameدر بخش 
 باز شود. Create New Style from Formatting تا پنجره  نماييم ميكليك  Modifyروي كليد 
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مورد قلم و اندازه نوع ، ها بخش عنوان. براي مثال براي نماييم ميلم و اندازه مورد نظر را انتخاب ق Formattingپس از آن از بخش 
. جهت ثبت يك حالت براي شودحالت مورد نظر ما نيز ثبت نام  ،Styleموجود در بخش  هاي لتدر حاتا  كنيم ميرا انتخاب  نظر

كرده و بر روي حالت مورد  Selectموجود را متن را  هاي يربخشو ز ها ش. سپس بخنماييم مينيز همين روش استفاده ها  زيربخش
و با  Referenceاز طريق منوي فهرست را در آن ايجاد كنيم رفته و  خواهيم يكه م اي حهبه صفپس از آن . نماييم مينظر كليك 

 را انتخاب كرده تا اين پنجره مشاهده شود: Table of Contents Insert، بخش Table of Contentsاستفاده از گزينه 
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 Word )Form افزار رمدر ن فرض يشحالت پ  دي فهرست است،بن كننده قالب نكه تعيي بندي تفهرس levelبراي انتخاب   توجه:

template( اين بخش در پنجره و نياز نيست در اين صورت اقدامي انجام شود.  باشد يمد نظر مTable of Contents  در بخش
Formats  .قابل تنظيم است 

 كليك كرده تا اين پنجره باز شود: Optionسپس بر كليد 
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كه با پاك كردن عدد كادر  فعال هستند Heading 3 و Heading 1 ،Heading 2 هاي زينهگ فرض پيشدر اين بخش به صورت 
براي نيم. براي مثال به حالتي كه ك گذاري مي ارهمورد نظرمان را پيدا كرده و به ترتيب اولويت شم Styleمقابل آنها در ليست نام 

دهيم. پس از فشردن  را اختصاص مي 2در نظر گرفتيم، اولويت  ها بخش و به حالتي كه براي زير 1در نظر گرفتيم، اولويت  ها شبخ
 اين پنجره گشوده خواهد شد: Modifyگرديم و با استفاده از گزينه  ) باز ميTable of Contentsبه پنجره قبلي( OKكليد 

 

خواهد شد تا قلم و اندازه فهرست را مشخص نماييد. توجه گشوده   Modify Styleپنجره  Modifyبا استفاده از گزينه مجدداً 
استفاده  Toc 2از  ها بخش زيرو براي  Toc 1ها  خش. براي مثال براي بدر نظر گرفته شده است Tocيك براي هر حالت  فرماييد

 تا فهرست ايجاد گردد.  فشاريم ميرا  OKبه پنجره قبلي بازگشته و مجدداً كليد  OKپس از فشردن كليد  كنيم مي

 و با استفاده از گزينه Referenceاز طريق منوي را ويرايش نموديد،  مطالبنكته: چنانچه 
 Update Table و گزينه Update entire table.فهرست را به روز رساني نماييد ، 

 

در زبانه فهرست در سمت چپ و اعداد در سمت راست قرار گرفت، متن فهرست را انتخاب كرده و  هاي نوشته اگرتوجه نماييد 
Home بر روي كليد Right-to-Left Text Direction فهرست به صورت استاندارد نمايش داده شود.  كليك نماييد تا  
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 نويسي ولفرم

 بايد مراحل ذيل را طي كرد: موضوع اين بايد آن از استفاده براي قدم اولين در و نيست word محيط استاندارد اجزاي از فرمول

 .كنيد انتخاب را Object گزينه  Insertمنوي از .1
 .كنيد انتخاب را Microsoft Equation 3.0 گزينه موجود هاي Object ليست در .2

 

 گيرد. در اختيار شما قرار مي Equationحال برنامه تغييراتي مي كند و يك باكس به جعبه ابزار به نام  

 

 بايد آنها از استفاده براي. تقابل درج اس مختلف هاي بندي دسته در رياضي هاي فرمول اقسام و انواع ابزار جعبه اين از استفاده با
 در تا كنيد انتخاب را خود نظر مورد اجزاي ابزار بهعج از سپس و داده قرار مناسب جاي در فرمول باكس داخل در را زن چشمك

 .نماييد وارد را مربوطه علايم و حروف بايد آخر در. شود درج نقطه آن

 نويسي نكات كليدي فرمول

 شود: پس از طي مراحل بالا نوار ابزار زير مشاهده مي  :غيير اندازه فرمولت

 

توان فرمول را در  موجود در آن ميهاي  ، پنجره زير گشوده خواهد شد كه با استفاده از گزينهDefine →Size از طريق گزينه
 :هاي مورد نظر درج نمود اندازه
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نويسي  فرمولپنجره ها فارسي باشند، پس از گشودن  اگر تمايل داريد اعداد فرمول :نويسي اعداد در فرمول نويسي فارسي

 : Define →Style)، از طريق گزينه Equation(پنجره 

 

 اي بدين شكل گشوده خواهد شد: پنجره

 

پس از فشردن را انتخاب نمود و ) BNazaninشود (مانند  آغاز مي Bهاي فارسي كه نامشان با  قلم Numberتوان در بخش  مي

 ها به صورت فارسي تايپ خواهند شد.  خواهيد ديد كه اعداد در كليه فرمول OK كليد

نويسي، فاصله ايجاد نماييد، از  چنانچه لازم است در حين فرمول هاي موجود در فرمول: ايجاد فاصله در بين كاراكتر

 استفاده نماييد.  Ctrl+Spaceكليدهاي تركيبي 
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 Wordروش ايجاد فهرست منابع در 

 كيكل Insert Citation نهيگز يرو بر Citations & Bibliography قسمت در Reference يمنو ازبراي ايجاد فهرست منابع، 
 :انتخاب كنيد را Add new source نهيگز بعد و ديكن

 

 شود:  يم ظاهر Create Source پنجره كار نيا انجام با

 

Type of Source :صورت به كه ديباش يم...)  و گزارش ت،يسا وب مقاله، كتاب، ليقب از( منبع نوع انتخاب به قادر قسمت نيا در 
 .است شده ميتنظ Book يرو بر فرض شيپ

Author :در مرتب و حيصح درج يبرا البته .گردد يم درج يخانوادگ نام و نام ليقب از مطلب سندهينو مشخصات قسمت نيا در 
  :دينمائ استفاده Edit نهيگز از است بهتر قسمت نيا
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عنوان، سال انتشار، شهر محل انتشار و ناشر را درج نماييد. همچنين  Create Source پنجره، در قسمت نياپس از پر كردن 
 ، اطلاعات بيشتري در خصوص منبع وارد نماييد:  Show All Bibliography Fields با ماركدار نمودن گزينهتوانيد  مي

 

 .شود يم اشاره متن در استفاده مورد منبع به بالا، پنجره نمودن OK با
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 شده ذكر ياستاندارها به توجه با ديتوان يم كه است شده انتخاب شينما Style در بخش APA استاندارد فرض شيپ صورت به
 .ديده رييتغ را آن خود متن نگارش يبرا

 كتاب اي مقاله يانتها در منابع فهرست جاديا يبرا د،يكرد رهيذخ بالا بيترت به را متن در استفاده مورد منابع يتمام نكهيا از پس
 قسمت از مناسب، Style انتخاب از پس ر،يز ريتصو طبق و داده قرار نظر مورد قسمت در را موس ينما مكان ستا يكاف خود

Bibliography، نهيگز Insert Bibliography ديكن انتخاب را: 

 

 چند ترفند كاربردي

 ها ها در ساير سيستم ثبات فونت. 1

 يها فونت با سپس و ديا كرده جاديا را يليفا Word مثل سيآف يافزارها نرم در كه باشد آمده شيپ زين شما يبرا حال به تا ديشا
 كه ديد ديخواه د،يكن يم منتقل يگريد وتريكامپ به ش،ينما اي و نتيپر يبرا را آن يوقت اما د،يا نموده پيتا را خود متن مختلف

 بر كه ديا كرده استفاده يفونت از وترتانيكامپ يرو بر شما كه است آن خاطر به موضوع نيا. است ختهير هم به تانيها فونت تمام
 :اقدامات ذيل را انجام دهيدبراي پيشگيري از اين مشكل  !ندارد وجود دوم ستميس يرو
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 Preserve بخش در شود، يم باز كه يا پنجره دررا انتخاب نماييد. Save  نهيگز  Optionنهيگزبا كليك بر منوي فايل و انتخاب 

fidelity when sharing this document ، چك باكسEmbed fonts in the file   ديبزنتيك  را. 

 كه يگريد ستميس هر در و شده دهيچسب ليفا به  ،يساز رهيذخ هنگام شما متن در رفته كار به يها قلم تمام نهيگز نيا انتخاب با
 .شود يم داده شينما يمشكل چيه بدون د،يكن باز را آن

. ديبزن زين  را آن كيت است بهتر كه دارد وجود Do not common system fonts عنوان با يا نهيگز بخش نيا در كه ديكن توجه
 .شود يم اديز اريبس ،يينها ليفا حجم جهينت در و چسبد يم ل،يفا به زين ستميس شفرضيپ يها قلم تمام صورت، نيا ريغ در

 ها ليفا يابيباز و خودكار رهيذخ. 2

 يك راه حل بسيار ساده وجود دارد.براي رفع اين مشكل  .ديكنن رهيذخ را ليفا اي شده قطع برق ،word افزار نرم با كار نيحممكن است 

  Save بخش در شود، يم باز كه يا پنجره دررا انتخاب نماييد. Save  نهيگز  Optionنهيگزبا كليك بر منوي فايل و انتخاب 

Document ، هاي چك باكس Save Auto Recover Information every و Keep the last AutoSaved version if I 

closed without saving  ديبزنتيك  را. 
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 بخش نيا وارد را دلخواه عدد نيكمتر. دارد وجود پنجره كي Save Auto Recover Information every بخش مقابل در
 رهيذخ شما ليفا در موجود مطالب خودكار طور به بار كي قهيدق كي هر د،يينما بخش نيا وارد را 1 عدد اگر مثال يبرا. ديينما

 مشخص كه يزمان در را شما اطلاعات ك،ياتومات صورت به word افزار نرمپس از اين .  ديكن كيكل ok دكمهسپس بر  .شد خواهد
 .كند يم رهيذخ ستميس يرو بر ، ديداشت متن در كه يرييتغ نيآخرو  نيكمتر با د،يا كرده

 براي درج كلمات پر تكرار Auto Correctروش ايجاد . 3

Auto Correct با كليك بر منوي براي تعريف آن به شكل زير عمل نماييد: رود.  به كار ميسهولت در تايپ كلمات پر تكرار  براي
  انتخاب نماييد.را  Auto Correct Option و پس از آن Proofing نهيگز  Optionنهيگزفايل و انتخاب 
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 پس از آن پنجره زير گشوده خواهد شد: 
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كلمه مورد نظر را به صورت كامل تايپ كنيد. سپس كليد را انتخاب  With حرف اختصاصي مورد نظر و در كادر Replaceدر كادر 
در كادر » دانشگاه علامه طباطبائي«در كادر اول و واژه » د«براي مثال در شكل بالا حرف . ديكن كيكل ok دكمهبر كرده و سپس 

بدون اين كه » دانشگاه علامه طباطبائي«واژه ، Spaceو بلافاصله كليد » د«نگاشته شد. پس از طي اين مراحل با تايپ حرف دوم 
  توسط شما تايپ شود، در متن درج خواهد شد.

 Word به اينترنت از متن كردن كپي صحيح روش. 4

  يا كليدهاي فوري  Homeاز منوي  Paste Special بهترين روش براي كپي كردن متن از اينترنت، استفاده از گزينه
Alt+Ctrl+V  :است 

 

 را انتخاب نماييد.  Unformatted Textاي كه گشوده خواهد شد، گزينه  در پنجره

 

 .شوند كارتان مزاحم اضافي، هاي شمايل و شكل و فرمت كه اين بدون شود مي چسبانده Word در شما متن فقط كار، اين با

  PowerPoint  به Word يها ليفا ميمستق ليتبد .5

 Choose يمنو از اكنون را انتخاب نماييد. Quick Access Toolbar  نهيگز  Optionنهيگزبا كليك بر منوي فايل و انتخاب 

commands from نهيگز Commands Not In The Ribbon ديينما انتخاب را. 
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 كيكل Add دكمه يرو بر و كرده انتخاب را آن و افتهي را Send to Microsoft PowerPoint نهيگز آن نييپا ستيل از سپس
 .ديكن كيكل OK دكمه يرو بر تينها درو  شود منتقل مقابل ستيل به نهيگز نيا تا ديكن

 نيتر بالا در نوار نيا. گرفت خواهد قرار Quick Access ابزار نوار در Send to Microsoft PowerPoint نهيگز كنيآ حال
 يرو بر كيكل با و كرده يفراخوان را خود نظر مورد Word ليفا است يكاف اكنون .دارد قرار صفحه چپ سمت در برنامه قسمت

 .ديكن PowerPoint طيمح وارد ماًًيمستق را ليفا نهيگز نيا

 دياسلا تريت به ليتبد  Powerpoint طيمح در باشند، داشته Heading 1 فرمت Word افزار نرم در كه يمتون ديكن دقتنكته: 
  .شد خواهند
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 بر و كليدهاي تركيبي  نكليدهاي ميا

كارهاي مورد نظر  زمان كمترين در ها آن از استفاده با توانيد مي شما. دارند زيادي كاربردهاي تركيبي كليدهاي و بر ميان كليدهاي
الزامي  Wordبراي كاربران  ها آنو دانستن هستند  خوردار بر اي العاده فوق اهميت از كليدها به همين دليل اين. خود را انجام دهيد

 . است

 رخي از اين كليدها خواهيم پرداخت:در اين بخش به معرفي ب

 عملكرد مورد انتظار بر نكليد ميا رديف
1 Esc     متغير كار لغو 
2 Ctrl+A Select All 
3 Ctrl+C  Copy 
4 Ctrl+X Cut 
5 Ctrl+V     Paste 
6 Alt+Ctrl+V Paste Special 
7 Ctrl+Z     Undo 
8 Ctrl+Y     Redo 
9 Ctrl+S     Save 
10 Ctrl+B     Bold 
11 Ctrl+U     Underline 
12 Ctrl+I     Italic 
13 Ctrl+P     Print 
14 Ctrl+G      Go To 
15 Ctrl+F جستجو 
16 Ctrl+O جديد فايل كردن باز 
17 Ctrl+]     بزرگ كردن اندازه فونت 
18 Ctrl+[     كوچك كردن اندازه فونت 
19 Ctrl+N    جديد پنجره يكباز كردن 
20 Ctrl+Enter  جديد صفحه يكباز كردن 
21 Delete    كردن حذف 
22 Shift+Delete    بازيافت سطل به بدون انتقال انتخابي آيتم كردن پاك 
23 Alt+F4     پنجره بستن 
24 Home  متن ويرايش حالت در خط اول به رفتن 
25 Ctrl+Home     دهد مي انتقال صفحه اول به را نما مكان ويرايش درحالت 
26 End متن ويرايش حالت در خط آخر به رفتن 
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 عملكرد مورد انتظار بر نكليد ميا رديف
27 Ctrl+End     دهد. مي انتقال صفحه آخر به را نما مكان ويرايش درحالت 
28 PageUp رود. مي بالا به صفحه به صفحه مرور حالت در 
29 PageDown رود. مي پايين به صفحه به صفحه مرور حالت در 
30 Shift+Tab  كه كاري وارونه Tab دهد. مي انجام 
31 Alt+Shift تغيير زبان نوشتاري برنامه 

32 Ctrl+Shift سمت راست 
انگليسـي را بـه فارسـي     پس از انتخاب شماره صفحه، شماره صفحه

 كند. تبديل مي

33 Ctrl+Shift  چپسمت 
 پس از انتخاب شماره صفحه، شماره صفحه فارسـي را بـه انگليسـي   

 كند. تبديل مي

34 Shift+F7 
در تايپ انگيسي نشانگر را در كنار يا زير كلمه مورد نشـر بـرده و از   

 اين كليد براي پيدا كردن مترادف استفاده كنيد.  
35 Shift+F5 ايد، برويد به قسمتي از متن كه به تازگي تغييري در آن ايجاد كرده. 
36 Shift+F3  تبديل حروف كوچك به بزرگ در متنSelect شده 

 در حالتي كه زبان برنامه فارسي است: Wordفزار  تركيبي براي نرمكليدهاي 
1 Shift+Q  تنوين فتحه 
2 Shift+W تنوين ضمه 
3 Shift+E تنوين كسره 
4 Shift+T (،) ويرگول 
5 Shift+Y (؛) نقطه ويرگول 
6 Shift+A فتحه 
7 Shift+S كسره 
8 Shift+D ضمه 
9 Shift+F تشديد 
10 Shift+G ساكن 
11 Shift+H آ 
12 Shift+B إ 
13 Shift+N أ 
14 Shift+M  ء 
15 Shift+V ؤ 
16 Shift+J امتداد حروف 

 


